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FORUM   Premier Support Fixed Charge  Support Forum  

    Web Classes – Unlimited access for all your staff  

    Best Practices - Solutions to Common Problems 
    Training Videos - On-Demand Learning 
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 ConnectPDF™ Dynamic PDF Client Intake & Import Utility  
 
 ConnectHotDocs™   Time Matters fully integrated with HotDocs 
 
 Voice Commands Dragon Voice Commands for Time Matters  
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material is provided without any warranty whatsoever, including, but not limited to, the implied warranties of 
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publication, or any parts thereof, may not be reproduced or transmitted in any form or by any means, without the prior written 

permission of Premier Software NJ, Inc., 1230 Brace Road, Cherry Hill, NJ 08034, (856) 429-3010. Photocopying any part of this 

book without the prior written consent of Premier Software is a violation of federal law.  

 If you believe materials are being copied without permission, please call 1-856-429-3010. 



Manual Conventions 

❖ Each lesson begins with an introduction to the topic. Read the 
introduction to get an overall understanding of the topic. 

❖ In the left column (Procedures), the steps for completing the task are 
listed. 

❖ In the right column (Comments/Prompts), explanations of the steps, 
names of screens that will display, and important information related to 
the individual steps are listed. 

❖ Text to be typed or clicked on is displayed in Bold. 

❖ Important Notes are preceded by a . 

❖ Helpful Shortcuts are preceded by a . 
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Lesson 1 
Getting Started 

➢ Time Matters – An Overview 

➢ Original Main Record Types  

➢ Starting Time Matters 

➢ Alerts, Reminders and Watches 

➢ The Time Matters Screen 

➢ Working with Lists 

➢ Navigating in a List 

➢ Changing Fields and Column Widths 

➢ Power Views 

➢ Working with Forms 
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What is Time Matters? 

Time Matters is a comprehensive, integrated system for managing essential 
practice management records - calendar, contacts, matters, documents, email, 
time and expense records and more.  

Time Matters is both a contact and matter centric relational database for  
Calendar Events and ToDo's; Contacts and Matters; E-mail, Documents, Notes 
Phone and Billing records.  Time Matters is flexible and customizable.  
Individual fields may be reclassified as text, numbers, dates, etc., with field labels 
relevant to your type of work.  Lists may be customized and pre-sorted in a 
variety of formats and displayed using Quick Tabs and specified record 
selections called Power Views. 

 Time Matters will allow you to achieve the following: 

1. Maintain a complete Calendar of Events and ToDo's. 

2. Create customized fields specific to your type of practice. 

3. Instantly see the Calendar and other records related to a specific 
Matter or Contact. 

4. Maintain a historical record of Events, ToDo’s and all other records . 

5. Synchronize calendars, address books, and phone numbers with 
Outlook or Outlook/Exchange, Palm or Blackberry software. 

6. Create and save a wide variety of reports. 

7. With proper customization, you can support each step of each process 
for improved efficiency and more effective management for a more 
profitable practice. 
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Time Matters Main Record Types 

Your client related information is captured on four main record types: 
Events and ToDo’s records populate your calendar.  Contacts and Matters 
records form your client centric and matter centric database.   All other 
supporting records such as documents, notes, email, phone, billing, user 
defined records, can be related into one integrated database.    

 

The Main Record Types 

What is an Event? 

Event records are date and time dependent calendar entries such as 
meetings, hearings, depositions, conferences, etc.  Events have a 
'time of day' and usually do not follow from day to day if not 
marked done. 

What is a ToDo? 

ToDo records are similar to events, but are not dependent on the 
time of day.   Todo records do not have a 'time of day' and usually 
do follow from day to day if not marked done.  For example,  a Todo 
may be for a follow-up of a information request, where the user will 
keep active from day to day until done.   

What are Contact records? 

Contact records are generally for people or organizations.  The 
Contact List acts much like a rolodex of all of the names, addresses, 
and phone numbers of individuals associated with your firm.  
Contact records can also be customized with extensive dates, 
numbers and names etc. for quick reference.  Other 'client' related 
records many be linked for an extensive history at the client level. 

What are Matter records? 

Matter records, are typically an electronic equivalent of a physical 
file.  Matters may be labeled as Project, File Case, Engagement, 
Claim or Account.  Matter records can also be customized with 
extensive dates, numbers and other related names etc. for quick 
reference.  Other 'matter' related records many be linked for an 
extensive history at the matter level. 
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Starting Time Matters 

Time Matters provides a training 'tutor' database with a separate set of records 
available for Training.  This training guide will be using the tutor database for 
training purposes.  To run Time Matters in your office, select Start, Programs, 
LexisNexis, and select Training Mode – Time Matters 10. 

 

Each user can customize the system so that the ‘Tip of the Day’ and the ‘Show 
Alerts and Reminders’ screens are initially either on or off.   Also, the record type 
you use most often can be set to open by default.  You can find these options 
under File/Setup/General/User Level/General.  Details on setting these options 
are covered in the Time Matters User Manual.   

 

 

Procedures  Comments/Prompts 

1. Click on the Windows 

 Start button, 
then Programs. 

Display the Programs list. 

2. Click on LexisNexis Display the Time Matters 
group of programs. 

3. Click on Training Mode –
Time Matters   

Start the Training mode of 
Time Matters for this class. 

You may get messages about 
updating the data. Simply follow 
the prompts to update the data. 
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Time Matters Login Screen  
 

 

4. Type TM Type your user ID. In the 
classroom, it is TM.  

Ask your system administrator 
for the Time Matters user ID and 
password for logging into the 
office database. 

5. Press Tab  Move to the Password field. 

6. Type TM Type your password.  In the 
classroom, your password is 
TM.  
See File> Set-up> Users and 
Security>  Security for options: 
- Save User ID and Password 
- Use of ‘strong’ passwords,  
- Disable login after 5 attempts 
- Use of Windows user name. 
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7. Click on OK Execute the log in procedure 
by clicking on OK. 
 
The Tip of the Day opens. 

 Note: You must register Time Matters within 60 days. A pop-up 

reminder will prompt you to register. You can press the 
Help>Activation Status to register on-line. 

 

 

     

 

8. Click on Close To turn off the Tip of the Day 
screen the next time you log 
on, click to uncheck the Show 

at Login checkbox. 

 

  Locate the Tips text file in the program directory.  This file contains the Text for Tips 

of the Day.  You can substitute your own tips, reminders, or comments, or add to the 
list. 



Getting Started with Time Matters 

Copyright 2009 • Premier Software - NJ, Inc.                                                          Page 7 

The Alerts, Reminders and Watches Screen 

 

The Alerts, Reminders and Watches screen pulls together the Events and 
ToDo’s, as well as, selected supporting records and Reminders for any given day. 
 

The Alerts and Reminders screen displays records that are: 

1. Actually scheduled for the day. 

2. Reminders for upcoming activities. 

3. Past due activities that have not been marked done. 

4. Notification of additions and changes made by others to your calendar.  

Most users elect to have the Alerts screen automatically appear when Time 
Matters is started 
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Working with the Alerts and Reminders Screen 
 

A list of icons is displayed at the top of the Alerts screen.  Each icon represents 
one of the record types displayed on the Alerts screen. 

 

Procedures  Comments/Prompts 

1. Highlight an Event on the 
Alerts screen 

Select the record you’d like to 
work with. 

2. Click on  Mark Record 
Done 

You can easily mark an Event 
or ToDo done from the Alerts 
screen. 

3. Click on Close Close the Alerts And 
Reminders screen. 

4. On the Alerts Toolbar  
Click View 

Se;lect the type of records to be 
displayed.  

5. On the Alerts Toolbar  
Click Options 

Make the appropriate 
selections to customize the 
Alerts dislay 

 

   To view the Alerts screen at a later time, click on  from the Main 

toolbar. 
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Working with the Navigator 
 

As you login, depending on your user settings,  an optional Navigator screen 
may appear.  Navigators group sets of commonly features or processes all in a 
single location  

Procedures  Comments/Prompts 

1. Highlight any Icon.  Select the feature you’d like to 
work with. 

2. Click on Options to 
add or remove 
Navigators  

You can customize your list of 
Navigators which will appear 
on the left side Navigator list. 
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The Time Matters Screen 

 

 

 

 

  

 

“User” is someone who operates the Time Matters program.  The system 
manager may set security for each user for various areas of  the program. 

 

“Staff” is typically someone who maintains a Calendar, and owns the record and 
is actually responsible for the work.   

  Other resources besides persons can be ‘staff’’. For instance, create a  

staff called ‘CONF’ to track in the calendar, when your conference room 
is going to be in use. 

  Staff may be set to Inactive which will suppress the staff from dropdown 

lists. On the Menu Bar, press Database> Staff> Change Record >and 
check ‘Make Inactive’ (at the top right of the Staff screen) 

Menu Bar 

Toolbar 

Data Directory Current 
User 

Default 
Staff 
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Working with Lists 

All record types can be viewed in a list format and each list has common 
features.  To locate a particular record, from within a list, from anywhere on the 
screen, type the first few characters of the desired record and the system will 
immediately advance to the record with the closest match using the ‘QuickPik’.  

Any record type list can be displayed by clicking on the associated icon on the 
toolbar.   For example, to see your list of Matters, click on the Matters icon on the 
main toolbar. 

Most record lists can be displayed by using a shortcut key.   

Shortcuts for displaying lists: 

F3      Displays the Event List 
F4      Displays the ToDo List 
F5      Displays the Contact List 
F6     Displays the Matter List 
F7   Displays the Note List 
F11  Displays the Email List 
F12  Displays the Billing (time and expense) List 
Ctrl+I  Displays the Email Inbox 
Ctrl+Shft+T  Opens a New Todo Record 
Ctrl+Shft+N Opens a New Note Record 

  

  For a printable chart of popular Time Matters short keys and other items, visit 

the free Resources area of Premier Software’s Managing with TimeMatters 
Forum http://support.premiersoftware.com/MT_Forum/  

 

Several lists may be active and displayed at the same time.  To do this, from the 
menu bar at the top of the screen, simply click Window  and select tile or 
cascade.  This will organize and display all the active lists on your screen. 

You can filter, sort, and arrange list records in the way most beneficial to you.  
Also, you can create “Quick Tabs” which show a special selection  and layout of 
records.  

http://support.premiersoftware.com/MT_Forum/
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Navigating in a List 

The Matter List will be used as an example for navigating in a list. However, all 
record lists function in the same manner. 

Procedures  Comments/Prompts 

1. Click on  Matters 
from the Main Toolbar    
(or simply press F6) 

The Matter list is opened.  
 

 Each list has a default sort order.  Matters are automatically sorted 
by Matter Reference.  However, you can sort 
(ascending/descending) on any column by clicking on the column 
heading.  Click again to reverse the order.  

 The QuickPik respects the column you are sorting by. 

 
 

 

           

Task Panel 

Power View 

 Panel 
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2. Type Mol The letters typed appear in the 
QuickPik box and your cursor 
will move to the first occurrence of 
the typed letters. 
 

 Once you are in the list, just start typing and the QuickPik will 

appear. The QuickPik box will display for 2.5 seconds and then it 
will disappear from the screen (the QuickPik reset time can be 
changed in File> Setup> General>, User level>, Lists tab). 
 

3. Press Page Down You can move through a list 
with Page Up and Page Down.  

4. Press Home Your cursor will move to the 
top of the screen. 
Press End to move to the bottom 
of the screen. 

5. Press Ctrl + Home Move to the top of the list. 
Press Ctrl+End to move to the 
end of the list. 

6. Click  on the Vertical 

Scroll bar 
Use the elevator button to 
Scroll down the list. You will 
see a view box with the matter 
reference. 

Use the Horizontal Scroll bar to 
view more columns. 

7. Click in the GoTo box 

 

The GoTo box is located in the 
top left-hand corner of the list 
screen. 

The GoTo box provides an 
alternate method of locating a 
name in the list. 

 You can also press Ctrl+G to display the GoTo box. 

GoTo Box 
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8. Type Arthur Type all or part of the name. 
The cursor does not move until 
you press Tab or Okay. 

9. Press Tab The indicated record is located. 

 

Changing Columns 
 

Open the Matter List. With your mouse pointer anywhere on the row of column 
headers, right-click and select Edit Columns. 

On the left are fields on the forms of the records in the selected list. On the right 
are the fields (columns) already on the list, in the order in which they appear.  
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Procedures  Comments/Prompts 

 1.   On the left, locate the 
field Opp Atty. 

The ‘Available Fields’ shows the 
columns (fields) on your form. 

 2.   Add the field using the 

 Add 
button. 

Add the desired column to the 
list. The field enters at the 
bottom of the list. 

 3.  From ‘In List’  
Highlight the Opp Atty 
field and click the 

 Up button. 

Put the columns in the desired 
order. 

 4.   Click  OK 

to save this selection. 
The settings are remembered for 
this list for this user. 

 

Changing the Column Width 

Dragging the column border in a column heading can easily change the width of 
the column. The changed width is automatically saved.  

Do this first: Open the Contact List. 

Procedures  Comments/Prompts 

1. Position your cursor to the 
right of the Last Name 

Column Heading  

Your cursor will change to a 
double-headed arrow. 

2. Drag the double-headed 
arrow to the right or left  

The column width will change 
as you drag the mouse. 
  

 The Column Width is automatically saved for the current user/list. 



Getting Started with Time Matters 

Page 16                                                          Copyright 2009 • Premier Software - NJ, Inc. 

 

Sorting in a List 
 

Each record type is displayed with a specified default sort order. Simply clicking 
on the column heading that represents the column you’d like to sort on can 
change the sort order.  An arrow will appear next to the column heading 
indicating the sort order.   Click on the column heading a second time to reverse 
the sort order. 

The sort order remains in affect as long as the window remains open.  Once the 
window is closed, the sort order will return to the default. 

                

 

 

Procedures  Comments/Prompts 

1. Open the Matter List. Click 
on the Column Heading 
Mat No 

The records are now sorted by 
Matter Number. 
Notice the arrow pointing up next 

to the column heading⎯the 
records are sorted in ascending 
order. 

2. Click on the Column 
Heading a second time 

The column is now sorted in 
descending order. 

3. Click on Mat Ref Set the sort order to another 
column. 

 The sort order will remain set until you close the record  window. When 
you return to this record type, the sort order  will be set back to the default. 

 You set default sort orders at a Program Level Setup, (Alt+Shift+P), 
program setup, lists, OR at a User Level (Alt+Shift+U), user level, Lists. 

The bold column is the selected sort. The 
right-side-up pyramid indicates the sort 
direction (ascending). 
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Views (Power Views) 
 

Each record on a list may also have a side or bottom view of selected details from 

the highlighted record.  Click on the  icon on the list toolbar to toggle 
between no Views, or any one of the pre-selected types of Power Views.  

 

Procedures  Comments/Prompts 

1. On te list toolbar, Click on 

the Power View icon  to 
activate the desired side or 
bottom View location.  

A window appears on the side 
or bottom. (If the icon is 
missing Press Options, Edit 
List Tool Bar and Select 
Powerview) 

2.  Click on the top matter. On 
the list toolbar click on 

 
and select Phone View. 

A new view displaying all 
Phone records is displayed in 
the Power View pane. 

3. In the Power View area , 
above the date column, 

click on  Phone. 

Clicking this button will toggle 
the list of Phone records 
between collapsed and viewed. 

4. In the Power View area click 

 Add.  

This will open a ‘Phone Call – 
Add’ form. 

5. Click cancel. Close the form without saving. 

 

 

Power View Area 
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Working with Update Forms 

 

Forms are used to enter, view and update data in each of the record types.  Each 
form is a collection of fields containing the information for any one record.  
Forms contain unique fields in addition to common fields found on all the record 
forms.  It is helpful to understand the information contained in the various fields 
before attempting to search data, run reports and perform other procedures. 

 

Each form is divided into sections indicated by the descriptive tabs at the top of 
the form.  The primary, secondary, and additional tabs contain pre-defined 
fields, as well as, user-definable fields, which can be customized to the 
requirements of each firm and each department. Custom fields can be linked to 
specific classification codes using Form Styles.  For example, if you select the 
Personal Injury matter classification code, you can set the form to display fields 
which are specific to this type of Matter.  Form styles are set using File> Setup> 
Templates>Form Styles.  

  

 

 

 

Form Tabs 

Areas 1 & 2 

Form Toolbar 
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Form Areas  

Forms are separated into Areas with each area numbered in the top-left corner.  
The area labels themselves can be customized.  Area 1 remains on the screen as 
you move through the other tabs.  This Area contains pertinent information for 
the selected record.  

  Press Alt + the number of the area to move to the first 

field in that Area. 

Form Toolbar 

 

The Form toolbar displays icons for the most commonly used form features.  
Activating a feature from this toolbar will only affect the currently displayed form. 

Form Tabs 

 

Form tabs are used to organize data for the current record.   

Primary  Displays the most important information for the record. 
This Tab contains six areas of fields with area four and five 
containing user-definable fields 

Secondary  Provides additional areas for addresses and more user-
definable fields. (Only available on the Matter and Contact 
forms.) 

Additional  Provides areas for user-definable fields. (Only available on 
the Matter and Contact forms.) 

Related Displays all records that are linked to the current record.  
This Tab can answer questions like “show me everything I 
have for this Client or Matter”. 

 Other Tabs Notes, Documents, Phone, E-mail, and other tabs display a 
list of those specific record types associated with this 
contact or matter.  All relevant information for the file can 
be found viewed, and edited from one location. 
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Drop-down  and Lookup  Fields 
 

A drop-down  field will display a list of available choices. You can only choose 
a single selection from a drop-down list. 

 

Lookup fields are used to link records, or open the table of the field type.  
Click on the Lookup field to display a list of associated records to choose from. 
Using ‘Code’ as an example, you can use a lookup field to add a new code, or to 
select multiple codes.  

 From within the field, press F2 as a shortcut for Lookup. 

Viewing an Existing Form 

Procedures  Comments/Prompts 

1. Locate the Molina v 

United Builders Matter 
Use QuickPik or the GoTo box 
to locate the desired record. 

2. Press Enter Highlight a record and press 
Enter key to open. 
You can also double-click on the 
desired record, or click on the 

change icon.  
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3. Click on Secondary 
 
View the information on the 
secondary screen. 
Notice the information in Area 1 
remains on the screen at all times. 

4. Click on Additional The Additional Tab includes 
several areas of customizable 
fields. 

5. Click on Related, and then 
Click on View 

Select the desired types of 
records related to this Matter. 

 
 You can also press Ctrl+Tab to move from Tab to Tab.  

6. Click on Primary Move back to the Primary Tab. 

7. On the form toolbar, Click 
on  to move to the 
Previous Record or Next 
Record 

You can also press  
CTRL  > or Ctrl < to move 
through the records on the list. 

8. Click on Close Close this record and return to 
the main Matter list. 
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Elements of a Form 

Do this first:  Open the MicroTech v. Megatech Matter. 

Procedures  Comments/Prompts 

1. Press Tab Move to the next field with the 
Tab key.  Press Shift+Tab to 
move back a field. 

2. Notice the  drop-down 
arrow 

A down triangle indicates a 
drop-down box, which 
provides a list of choices.  

3. Notice the  Lookup 

button for Client The  indicates a Lookup 
field, which enables you to link 
other records to this record.  
For example, a list of Contacts 
will appear when linking a 
Contact to a Matter. 
 

   The Lookup icon will change to icon when the link  has been 

made to relate the displayed record to another record. 

 Press F2 as a shortcut to Lookup. 

4. Click on X Close The form is closed and you are 
returned to the Matter List. 

 



 

 

 

 

 

 

 

Thank you for using our training 
guide for Time Matters. 
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